
Intro 

 

 

PrintKey-Pro is a system tray-based program that captures all or any part of the picture on your 

monitor screen with the press of the Print Screen key (or any other available Hotkey combination 

that you configure). 

 

Adjust the captured picture's brightness, contrast, color balance, size, color invert, and convert to 

gray scale or black and white. 

 

Edit the image using the image editor of your choice. 

 

Pictures can be printed or saved to your assigned folder in many formats:  BMP, GIF (non LZW), 

ICO, JPG, JPG2K, PCX, PDF, PNG or TIF. 

 

PrintKey-Pro can capture the full screen, the active window, the client area, or any rectangular or 

circular area selected, including or without showing the cursor.  

 

Text or free hand drawing can be inserted in the selected area.   

 

The picture can be previewed, dated, and may include system information, user information as 

well as composed footer text before printing. 

 

PrintKey-Pro v1.05 can be used only with Windows® 2000, Windows® 2003, Windows® XP 

or Windows® Vista. 

 

Since Compaq® Laptops or Desktops use the Print Screen key for other internal purposes, 

another key must be used to capture the Active or Desktop window. The 'Pause' key or a 

combination with the Pause Break key (for example, Ctrl+Pause Break) may be entered in the 

PrintKey-Pro Hotkey Menu to implement a shortcut compatible with PrintKey-Pro. 

 

Service Pack 2 or higher is required with Windows® 2000. 

Service Pack 1 or higher is required with Windows® XP. 

 

Microsoft service packs  

 

 

 

 

 

 



Faq 

 

General 

 

PrintKey-Pro v1.01 through v1.04 is compatible with Microsoft Win95, Win95B, Win98, Win98 SE, 

WinNT4.0, Win2000, WinME, WinXP and Win2003. 

 

PrintKey-Pro v1.05 can be used only with Win2000, Win2003, WinXP or Vista. 

 

1. How do I get PrintKey-Pro? 

 

On the download page, click on your selected Download version. Be sure to create a new folder 

for your download in the 'Save As' menu. When the download is completed, double click on the 

folder on your Desktop to Install the program in your computer. If the icon does not appear on 

your screen when installation is completed, shut down your computer and boot up again to place 

the PrintKey-Pro icon in the lower system tray on your screen.  

 

For v1.05 download and installations, follow the GUI instructions. These are illustrated on our 

Download and Installation pages and will appear step-by-step during your installation. 

 

2. I downloaded and installed PrintKey-Pro. How do I register my copy? 

 

You must first purchase a registration keycode. Click on this link: order or click on the ORDER 

button at warecentral.com to submit an order.  

 

For additional registering information, press the Print Screen key on your keyboard, click on Help 

at the top of the PrintKey-Pro toolbar, click on PrintKey-Pro Help, click on Installing and 

Registering. Click on the Registering selection. 

 

3. Why do I need to register PrintKey-Pro? 

 

You have 30 days to evaluate all the features of PrintKey-Pro. After that period, you must order a 

registration keycode and enter that information in the PrintKey-Pro Register in your computer to 

continue using PrintKey-Pro. You cannot download/install another copy, another version, or use a 

CD installation to avoid the Register. 

 

4. If I lose my registration keycode information or my keycode does not work, what should 

I do? 

 

Contact sales@warecentral.com 

 

5. Is PrintKey-Pro available in CDROM form? 

 

You may choose to purchase a CD in conjunction with a licensed registration. A licensed 

registration keycode is required and must be entered in your computer to keep the program 

active. 

 

6. Can I purchase multiple licenses of PrintKey-Pro? 

 

The following discounts will be offered to companies or organizations registering as a group and 

making a single payment transaction.  
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Quantity   Price per user/computer 

3-5   $18.95 each 

6-10   $15.95 each 

11-49   $12.95 each 

50-249   $9.95 each 

250-999   $8.95 each 

1000=Site License    Send an e-mail inquiry to sales@warecentral.com  

  

7. If I already have a registered copy of PrintKey-Pro will I be required to pay for a minor 

upgrade? 

 

A registered licensee of PrintKey-Pro may download a Minor upgrade such as v1.01, v1.02, 

v1.03, v1.04, v1.05, etc. without additional fees.  

 

8. If I already have a registered copy of PrintKey-Pro will I be required to pay for a major 

upgrade? 

 

Major upgrades of 1.1, 1.2 (etc.) will be offered at discounted fees to registered users of PrintKey-

Pro.  

 

9. Is PrintKey-Pro available for Mac? 

 

No. PrintKey-Pro is only available for Windows. 

 

10. Is there a version of PrintKey-Pro available for Windows 3.1? 

 

PrintKey-Pro is not compatible with Win3.1. 

 

11. Which operating systems is PrintKey-Pro compatible with? 

  

PrintKey-Pro v1.01 through v1.04 is compatible with Microsoft Win95, Win95B, Win98, Win98 SE, 

WinNT4.0, Win2000, WinME, WinXP and Win2003. 

PrintKey-Pro v1.05 can be used only with Win2000, Win2003, WinXP or Vista. 

 

12. I have been using an old version of Printkey. Can I still use Printkey v4.x or v5.x 

without registration? 

 

You may continue to use old versions of Printkey. These versions are not registered or 

supported.  

 

Registered versions of PrintKey-Pro offer many advanced features, including support for WinXP 

in PrintKey-Pro v1.03, v1.04 and support for Vista in v1.05.  

 

13. Can I still download Printkey v4.x or v5.x? 

 

The freeware versions Printkey v4.x and v5.x are no longer supported or available. 

 

14. Is support available for Printkey v4.x or v5.x? 

 

WareCentral does not support freeware. Registered shareware (PrintKey-Pro) is supported and 

we will respond to your questions. 
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Technical 

 

1. How do I install PrintKey-Pro? 

 

Click on the DOWNLOAD button at www.warecentral.com then select and click on a single 

version Download link. Please read the Installing and Registering information posted for the 

version you have downloaded. 

 

2. How do I use PrintKey-Pro? 

 

When you have downloaded and installed a copy of the program in your computer, press the 

Print Screen key on your keyboard, click on Help at the top of your screen, click on PrintKey-Pro 

Help to open the Help Menu. We recommend the PrintKey-Pro Window, Toolbar section, and the 

Printing section in the Help Menu. You may print any of the Help Menu pages for reference. 

 

3. Can PrintKey-Pro capture the whole page of an article or only capture what is shown on 

my computer screen? 

 

PrintKey-Pro can capture only what is shown on your computer screen. You may choose to 

capture the entire screen or only a portion of it. 

 

Otherwise, you can hold down the left mouse button and move the mouse to highlight and scroll 

through pages. Release the mouse button when you have highlighted a selection or multiple 

pages. Use CTRL C, open a Word document page, and use CTRL V or the  

paste icon in Word to paste the pages into your document.  

 

4. Can PrintKey-Pro capture a screen in Full DOS mode? 

 

No. 

 

5. Can I use PrintKey-Pro with Dot Matrix, Laser, Ink Jet and Network printers? 

 

Yes. Assign a printer under the Page icon or use the adjacent arrow for Printer Setup in PrintKey-

Pro. Default will use your Windows settings. 

 

6. Can I use PrintKey-Pro with my FAX machine? 

 

Yes, you may send the output to your fax printer. 

 

7. Can I use PrintKey-Pro on LINUX? 

 

PrintKey-Pro will not work with any Linux distribution. 

 

 

 

 

www.warecentral.com then select and click on a single 


Features 

 

File Format Load/Save 

 

BMP 

CUR (Load Only) 

GIF (Non LZW) 

ICO (Load Only) 

JPG, JPEG, JPG2K 

PCX 

PDF (Save Only) 

PNG 

TIF, TIFF 

WMF, EMF 

 

Actions 

 

Automatic Save 

Automatic Save with Date/Time 

Automatic Save with Definable Rectangle 

Blur 

Bump Map 

Change HSL 

Change HSV 

Change Size Proportional 

Change View 

Clipboard 

Get Active Window 

Get Circular Area 

Get Desktop 

Get Pull Down Menus 

Get Rectangular Area 

Lens 

MultiMonitor Support 

Print Preview 

Reposition Circular Area 

Reposition Rectangular Area 

Resize 

Rotate 

Send Email 

Undo 

User Filters 

Wave 

 

System Info 

 

Minimum Memory required 128 Mb 

CPU minimum 1.2 Ghz 

 

Operating Systems Supported 

 

Win2000 (all versions) 

Win2003 (all versions, R2) 



WinXP (Std, Pro, Media) 

Vista (all versions) 

 

All Rights reserved (c)1998-2008 by WareCentral  

 

 

What's New 

 

 

What's New in Version 1.05 

 

PrintKey-Pro is now digitally signed. This guarantees the program authenticity. 

 

Additions: 

 

Write as PDF. 

Write as ICO. 

Load as JPEG 2000. 

Swap color added in Standard Editing menu. 

Can use a Transparent windows program with PrintKey-Pro v1.05. 

The Paper Format and the Printer Paper Tray will be kept under 'Printer setup' 

 

Changes: 

 

Version 1.05 supports Win2000, Win2003, XP and Vista. Support for NT, Win95, Win98 and 

WinME is removed. 

User interface look and feel of XP and Vista. 

Cosmetic window and menu changes. 

Package and executable digitally signed.  

Help Menu revisions. 

 

Corrections: 

 

Multiple image bug corrected. 

Inverse colors corrected. 

Substitute colors bug corrected. 

Short Date Format can be used in registering program. 

Fixed the bottom border space printing bug. 

Fixed Standard Editing bug. 

Fixed printing problems with some HP Laser printers. 

Fixed Direct print bug with the clipboard. 

Fixed Save picture bug with the clipboard. 

 

 

What's New in Version 1.04 

 

Additions: 

 

Easily Installable Licenses using 'PKey_Pro.INI' file. 

MSI Installation (using InstallShield®) can be running in silent mode and as Administrator install 

for network installations. 

Added 'Remove' button on the registration form. (Use to uninstall the application after 30 days 



expiration) 

Additional XP compatibility 

Multiple Undo ( Max. 16 ). Click on Edit in the top row of the PrintKey-Pro toolbar or use Ctrl+Z. 

Added Optimize Print (Printing can be optimized to reduce the size of the picture. Click on the 

Page icon to find this feature) 

Added Grayscale (Print in grayscale to save color ink. Click on the Page icon to find this feature). 

Added 'Define Custom Rectangle' for timed captures. (Click on the arrow adjacent to the Clock 

icon in PrintKey-Pro to find this feature).  

Added a Confirm Box menu for Automatic Save.  

Auto numbering has leading zeros for better sorting. 

Actual cursor is shown if 'include Cursor' in Options is enabled. 

Faster loading of Pictures. 

 

Changes: 

 

New style Toolbar (smaller icon). 

New style Help file (new windows html format). 

Default Picture Format is now PNG 

Cosmetic changes to 'Load Picture' and 'Save Picture' Dialogs 

Removed Standard Printing (Enhanced Printing Engine is always on). 

Picture background in the PrintKey-Pro Window is white instead of gray. 

Revisions and additional information in Help Menu. 

 

Corrections: 

 

Fixed a rare 'Invalid Time' bug on calculating the evaluation length. 

Fixed bug with parameters not saved if PrintKey-Pro was terminated and not closed. 

Older versions of PrintKey or PrintKey-Pro will be terminated on installion of the new version. 

All parameters will be set to default on uninstalling. 

Fixed a Suspend bug. 

Print Preview bug fixed. 

Available Printers bug fixed. 

Fixed Printing bug (that could make large print jobs). 

Fixed Document Title not showing on printing. 

Fixed a bug with Selections. 

Fixed Substitute Color function. 

Turn 90° corrected.  

 

 

Installation 

 

 

NOTE: PrintKey-Pro v1.05 will automatically upgrade v1.04. You will not need to Uninstall 

PrintKey-Pro v1.04 prior to installation of PrintKey-Pro v1.05. All other Beta versions of 

PrintKey or other versions of PrintKey-Pro should be Uninstalled before installing the final 

version of v1.05. 

 

PrintKey-Pro v1.05 can be installed in different ways because the package is built with 

InstallShield ®  using Microsoft Windows Installer Technology that produces an MSI 

package. 

 

  



Single User Installation 

 

To install PrintKey-Pro v1.05, double click on the Pkey_Pro_v105.exe (compressed package) 

Folder and follow the GUI (Graphical User Interface). Enter all required information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After installing PrintKey-Pro v1.05 you can register it shortly thereafter or use the program without 

registering for 30 Days of Evaluation. If you do not enter the registration keycode in your 

computer, the program will fail to function on the 31st day. 

 

Multiple User Installation in a Single Computer 

 

If you want to install PrintKey-Pro for all users on a single computer running Win2000, Win2003, 

XP or Vista install it as an Administrator of that computer and when prompted for the destination 

folder you must select the ALL USER folder under Documents and Settings. 

 

Network User Installation Silently 

 

To Install PrintKey-Pro without user intervention use the following method: 

 

Go under Run and press Browse now search for the installation Pkey_pro_v105.exe and enter 

the following qualifiers /S /v/qn  

( 1 space after /S ) after the file name. 

 

example: 

 

 Press OK. PrintKey-Pro v1.05 will be installed Silently to the Default Directory \Program 

Files\WareCentral\PrintKey-Pro. 



 

 

Administrative Installation 

 

To Extract the package for using it later with extended functionality you must run it with the /a 

Qualifier. This will extract all files to the selected directory which should be a network share ( 

\\Computer\share ). Please be sure that this share is accessible to all users who want to install 

PrintKey-Pro. You may also implement security on the network share. 

 

example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Press Install. All files will be extracted to the specified folder (share).  

A User may then install the program by running the PrintKey_Pro_v105.MSI file inside that share. 

 

To install a MSI file Silently, use this syntax: MSIEXEC /qn /i c:\Apps\Myapp.MSI  

 

Alternatively, you can set the installation folder on the command line as follows: 

 

MSIEXEC /qn /i c:\Apps\Myapp.MSI INSTALLDIR=c:\MyApps\PrintKey-Pro 

 



Example: 

 

  

 

If you require additional detailed information about MSIEXEC command line parameters and 

properties, visit the Microsoft Support web site. 

 

 

To UNINSTALL silently in a network use the following on a command line or under Run:  

 

For Version 1.05 

 

msiexec /qn /norestart /x {5EFA4EA3-0604-458C-A06D-485F6B2724C9}   

 

For Version 1.04 

 

msiexec /qn /norestart /x {FBD461E5-52C3-4F46-A484-2E64D8043521}  

 

 

Registration 

 

 

PrintKey-Pro may be registered in a single computer, separately in a small number of computers 

or silently in a network. 

 

To order a licensed registration keycode, visit warecentral.com and click on the ORDER button. 

Order information can be submitted Online securely, by Mail or by Fax with a printed copy of your 

order form, or submitted online using the Phone Order form. You may pay for your registration 

license by submitting credit card information, or choosing  Paypal. For Phone orders use your 

Tracking ID when you contact the processing center to provide credit card information.  

 

Any submitted order will generate a response to the email address you provided in that order 

entry. The email will include a Tracking ID as well as a Link for an invoice which may be used as 

a Purchase Order document. 

 

Your Order will be held until payment is confirmed. Upon confirmation of payment, your 

registration name and matching keycode (listed as Serial Number in the license record) will be 

forwarded to the e-mail address you provided in your order information. 

 

 



Manual Registration 

 

Single User Registration 

 

Single user registration may be used if you purchased a licensed registration keycode for a single 

computer or a small number of licenses for a group of computers. The registration name and 

matching keycode are linked---if you change or alter the registration name on record, a mismatch 

and an 'invalid' error message will result. To keep the program active, in this procedure the exact 

license record information must be entered manually in a computer--if more than one user profile 

then enter the registration information for each User Profile, using again the exact registration 

name and linked matching keycode on record while in each user profile. (Alternatively, see All 

User or Network Installation and Automatic Registering information.) 

 

Registration information may be entered in a computer any time after installing PrintKey-Pro and 

running it for the first time, as well as after the 30-day evaluation time has expired. The 

downloads for PrintKey-Pro are FULL-FEATURE; you do not need to download a new copy if 

your trial period has expired. If you download/install a second copy of PrintKey-Pro online or use 

a CD to install a second copy without registering the original copy, the program will fail to open or 

function until the registration information is entered in a computer. Be sure to Register your 

PrintKey-Pro installation in your computer before you Uninstall any original copy or 

download an upgrade for the program. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To complete the registration process in a computer before the trial evaluation period has 

expired: 

 

(1) Press the Print Screen key on your keyboard, 

(2) Click on Help in the PrintKey-Pro toolbar at the top of your screen, 

(3) Click on Register. 

 

  

 



This form will appear: 

 

  

 

Do not use the Buy Now button in this menu unless you need to order a license, additional 

licenses or registration keycodes. 

 

Click on Remove only if you do NOT want to keep and Register the program. If you click on 

Remove, you will need to order a registration keycode and enter the registration information in 

your computer to use any version of PrintKey-Pro. An additional online download or CD 

installation of any version of PrintKey-Pro will not avoid the Register. 

 

Always Register your initial installation of PrintKey-Pro; your validated registration 

footprint will then transfer automatically to any Minor upgrade. 

 

To Register PrintKey-Pro: 

(1) Copy and Paste or enter exactly the registration name and keycode provided in your e-mail 

confirmation into the Register entry boxes. 

(2) Click on the Key in the Register menu to confirm.  

(3) Click on Close to close the Register.   

 

  

 

When you click OK, the 30-day trial message will be removed from the program.  

 

If your 30-day trial period for Printkey-Pro expired or you need to re-enter your registration 

information due to a change in your computer or operating system: 

 



Click on Start, click on All Programs listing, scroll to find PrintKey-Pro and click on PrintKey-Pro 

to open the listing. 

 

 

 

 

(1) Click on PrintKey-Pro below the main program listing in Vista or in XP follow the arrow to the 

right of the main listing and click on PrintKey-Pro at that location.  

(2) The Register menu will come on screen if you need to validate or re-enter your registration 

information. 

(3) Copy and Paste or enter exactly the registration name and keycode provided in your e-mail 

confirmation into the Register entry boxes. 

(4) Click on the Key in the Register menu to confirm.  

(5) Click on Close to close the Register. 

 

  

 

When you click OK, the 30-day trial message will be removed from the program.  

 

To verify program registration status in a computer, press the Print Screen key on your keyboard, 

click on Help in the PrintKey-Pro toolbar, click on About. The licensed registration name should 

be shown in the 'Registered To' box. Click OK to close the menu. 

 

 

Automatic Registration in Networks 

 

This is also called Administrator Registration 

 

If you have a large number of computers to register, then Automatic Registration is the preferred 

method. Network Administrators or System Administrators can perform an Administrative Install 

of the package on a Network share. (See Administrative Installation in Installation in this Help 

Menu.) 

 

The default location for PrintKey-Pro is: C:\Program Files\WareCentral\PrintKey-Pro 

Alternatively, the program may be stored in another drive or placed in a network Share or 

Directory.    



 

 

To navigate to the .ini stored in a computer: 

 

Click on Start 

Click on My Computer 

Double click on the Drive where you stored the File Folder 

Double click on the Folder where you stored the program (default will be listed as Program Files 

folder) 

If files are hidden, click on 'Show the contents of this folder' 

Double click on the listed Folder that contains PrintKey-Pro (default will be listed as WareCentral 

folder) 

Double click on the folder for PrintKey-Pro to show and access the .ini  

which can then be edited (Notepad, Write) to include the license registration information. 

 

 

 

 

  

 

Using this method, every user who installs Printkey-Pro from that Share will be registered 

Automatically. Individual users will not need to enter registration information at workstations to 

use the program. 

 

Note: Installing can be done silently (no user intervention) and can be run from a Batch script ( 

*.BAT ) 

 

PKey_Pro.ini can also be copied to the User(s) installation directly and this will register it on the 

first run of PrintKey-Pro v1.05.  

 

 



Toolbar 

 

 

  

 

The Toolbar is activated when you: 

 

(1) Press the Print Screen key on your keyboard, 

(2) Or double left click on the PrintKey-Pro icon in the lower tray on your screen,  

(3) Or right click on the PrintKey-Pro icon and click on Open.  

 

The following procedures are activated by clicking on a selected Icon or on an arrow 

located next to an icon in the Toolbar.   

 

Keyboard shortcuts may be used as noted: 

 

Load 

Ctrl+L 

Loads the following types of Image files:  

BMP, EMF, GIF, ICO, JPG, JPEG, JPG2K, PCX, PNG, TIF, TIFF, or WMF. 

 

(1) Click on the Load icon. 

(2) Select files in your computer that you want to load. 

 

Click on the small 'arrow' located at the right side of the Load button in the Toolbar to show a list 

of your loaded files. 

 

Save 

Ctrl+S 

Saves the current image as any of the following types:  BMP, GIF, ICO, JPG, JPG2K, PCX, PDF, 

PNG, TIF or TIFF. 

 

To select an image type and choose a folder for your screen captures: 

 

(1) Click on Options in the toolbar. 

(2) Click on Save and Picture Type Defaults. 

(3) Select an Image Type in the menu. 

(4) Enter a Picture or File Name. 

(5) Check or uncheck (disable) Auto Numbering as preferred. 

(6) Click on the Change box in the Save and Picture Type Defaults menu to designate a folder for 

your saved screen captures. 

(7) Click on the Close box in the lower right corner of the menu to keep your settings. 

 

Click on the Save icon in the Toolbar to send your screen capture to your Folder assigned under 

Save and Picture Type Defaults. 

 

 

 



E-Mail 

Ctrl+M 

Sends the current image on the screen as an E-Mail attachment. 

For E-Mail setup information, press the Print Screen key on your keyboard, click on Help at the 

top of your screen, select PrintKey-Pro Help and open Send as E-Mail. 

 

Paste 

Ctrl+V 

Pastes an Image from the Clipboard to the Working Area of PrintKey-Pro. 

Clipboard is virtual in some Windows operating systems. 

 

 

 

Copy 

Ctrl+C 

Copies the current Image selection in the PrintKey-Pro Working Area to the Clipboard or to a 

document when you click on Paste while in the alternate program. 

 

How to Copy and Paste a screen capture into a document: 

 

(1) Press the Print Screen key on your keyboard. 

(2) Place the crosshairs in a corner of the area you want to capture. 

(3) Hold down the left mouse button and move your mouse to include the portion of the screen 

that you want to capture, then release the left mouse button. 

(4) Click on the Copy icon in the PrintKey-Pro toolbar. 

(5) Open or click on an open document page on which you want to copy the screen capture. 

(6) Place your cursor in the document and click on the Paste icon in the document toolbar. 

 

The selection will transfer to the document in accordance with your cursor placement and spacing 

within the document. A right click on the transferred object in the document (while in Word® and 

other programs) will activate pop up menus that may be used for positioning and other changes. 

 

Cut 

Ctrl+X 

Cut will remove a selected area within a rectangular or circular area. The Cut icon will appear 

grayed out until you select a rectangular or circular area. Use the crosshairs and your mouse to 

select the area you want to remove. When your rectangular or circular area is selected, the Cut 

icon will appear in color. Click on the Cut icon to remove the selected part of your screen capture. 

 

Note: The Cut icon will automatically disable if you have Auto Crop enabled. To use the 

Cut icon, uncheck (disable) Auto Crop in Options. 

 

How to Get a Pull Down Menu using Cut: 

 

(1) With a program toolbar on screen, click on the Pull Down Menu selection that you want to 

capture. 

(2) With the cursor near the Pull Down Menu to keep it active, press the Print Screen key on the 

keyboard. 

(3) Place the crosshairs in a corner of the area that you want to capture. 

(4) Hold down the left mouse button and move the mouse to include all parts of the Pull Down 

Menu that you want to capture, then release the left mouse button. 

(5) To remove any unwanted parts of your captured Pull Down Menu, place the cursor on a 

corner of the area that you want to remove. 

(6) Hold down the left mouse button and move the mouse to include the part you want to remove, 



then release the left mouse button. 

(7) Click on the Cut icon. 

 

Proceed as preferred: 

Click on the Print Icon in the toolbar to print. 

Click on the Copy Icon in the toolbar to copy the screen capture to a document. 

Open a document page, place the cursor on the page, then use CTRL+V or click on the Paste 

icon in that program to transfer the screen capture to the document.   

See the Save section above to assign a folder for your screen captures. 

 

Crop 

Ctrl+R 

Crops a selection in the Working Area of PrintKey-Pro. Crop will capture the area within a 

rectangular or circular area. The Crop icon will appear grayed out until you select a rectangular or 

circular area. When the rectangular or circular area is selected, the Crop icon will appear in color. 

Click on the Crop Icon to capture a selected portion of your screen. If needed use the Cut icon to 

remove unwanted areas of your screen capture. 

 

To use Crop automatically or repeatedly, rather than use a combination of the Crop and Cut icons 

in your procedure, click on Options in the top of the Toolbar, check (enable) Auto Crop. 

 

How to Auto Crop a circular area: 

 

(1) Press the Print Screen key on your keyboard. 

(2) Right click to bring up the pop-up menu. 

(3) Left click on Select Circular Area. 

(4) Place the crosshairs in the center of the area that you want to capture. 

(5) Hold down the left mouse button and move your mouse to include the portion on screen that 

you want to capture in a circular area, then release the left mouse button. 

 

To capture a perfect circle, press and hold the ALT key while dragging your mouse. 

 

Rectangle 

Shows the Full Screen and enables the selection of a Rectangular Area for cropping to the 

Working Area of PrintKey-Pro. 

 

How to use the Rectangle icon: 

 

With Auto Crop in Options disabled 

(1) Press the Print Screen key on your keyboard. 

(2) Click on the Rectangle (Rect.) icon in the toolbar. 

(3) Place the crosshairs in a corner of the area that you want to capture. 

(4) Hold down the left mouse button and move your mouse to include the portion on screen that 

you want to capture, then release the left mouse button. 

(5) With the crosshairs outside the rectangle perimeter press ESC or the Enter key on your 

keyboard to capture your rectangle. 

Notes: 

(a) With the crosshairs within the rectangle the rectangular area can be moved. 

(b) With the grip at the rectangle perimeter change the size. 

(c) With the crosshairs outside the rectangle perimeter right click to select a standard size. 

 

Proceed as preferred: 

Click on the Print Icon in the toolbar to print. 

Click on the Copy Icon in the toolbar to copy the screen capture to a document. 



Open a document page, place the cursor on the page, then use CTRL+V or click on the Paste 

icon in that program to transfer the screen capture to the document.  

See the Save section above to assign a folder for your screen captures. 

 

How to select a Predefined Rectangle: 

 

(1) Press the Print Screen key on your keyboard. 

(2) Click on the Rectangle icon in the toolbar. 

(3) Right click to view the rectangle size menu. 

(4) Place the cursor on Rectangles and follow the arrow to select a size, then left click.  

(5) If you want to move the rectangle, place the cursor inside the sized Rectangle, hold down the 

left mouse button and move your mouse to place the Rectangle on the portion of the screen that 

you want to capture. 

(6) Press ESC or the Enter key on your keyboard to keep your captured rectangle. 

 

Note: Auto Crop in Options must be disabled (unchecked) to use the Predefined Rectangle 

procedure.  

 

How to Define a custom Rectangle Size:   

 

(1) Press the Print Screen key  on your keyboard. 

(2) Use the crosshairs to outline the Rectangle Size.  

(3) Right click to view the menu. 

(4) Click on Rectangles and follow the arrow, click on Define. 

(5) The Size of your Rectangle is shown in the Status Bar panel below the Working Area. 

(6) Enter the Width and Height in the Custom Rectangle menu. 

(7) Click on the Close box in the lower left of the Custom Rectangle menu to keep your 

Rectangle Size setting. 

 

Your new custom Rectangle Size will be listed above Define in the Rectangle Size menu 

and can be selected when you right click  after a screen is captured. A custom Defined 

rectangle will reference the same part of your screen until or unless you move and assign 

the rectangle to a diffferent part of the screen. 

  

Note: An alternate route for Get Rectangular Area may be used when you right click on the 

PrintKey-Pro icon in the lower tray of your screen and select that option. Right click to select a 

standard or defined size or use the crosshairs and your mouse to capture a rectangle. Click on 

ESC or Enter to enable the PrintKey-Pro Toolbar when this route is taken. 

 

The right click pop up menu also includes Select Circular Area, Insert Text, Free Hand Draw, 

Standard Editing menu and Advanced Editing menu shortcuts. 

 

Object 

Shows the full screen and allows selection of an Object. Objects are Toolbars, Status bars, 

Pictures inside windows, and the Client area of Windows®. 

 

How to capture an Object: 

 

(1) With the Object on screen, press the Print Screen key. 

(2) Click on the Object icon in the toolbar. 

(3) Place your cursor on the Object that you want to capture. 

(4) Press the mouse button. 

(5) The captured Object will appear in the PrintKey-Pro Working Space. 

 



Edit 

Ctrl+E 

Opens the Standard Editing Window to edit the selected capture.  

For an illustration of this menu see Standard Editing Window in the PrintKey-Pro Help menu. 

 

Off/On Clock 

 

This feature will capture a monitor screen automatically at timed intervals.  

Clicking the Save icon or using Ctrl+S will save a screen only when a user decides to save 

a screen. See Defaults, Save and Picture Type Defaults, in this Help Menu to setup a 

Folder to Save your screen captures. 

 

ON selects the Automated Desktop capture function to automatically capture the screen and 

save it at your selected intervals. 

 

(1) Timer Setup: 

 

Use the arrow at the right of the Clock icon to pull down the Timer Setup menu. For Timer Setup 

details see Automated Save in this PrintKey-Pro Help menu. 

 

Use the arrow at the right of the Clock icon to Define a Rectangle Size or a part of your screen 

that you want to capture automatically when the Clock is On. 

 

(2) Define Captured Rectangle: 

 

Use this feature to Define the part of the screen that you want to save automatically to your 

assigned folder when you enable the Timer Setup and use Automatic Save. 

 

To setup automatic saving of a portion of your screen, drag the rectangle on the screen at the 

position and size that you want to capture, then press ESC. All timed screen captures will then 

save only your selected portion of the screen. 

 

Page 

Opens the Printer Page Setup and Print Preview screen. Click on the arrow at the right of the 

Page icon to Select a Printer and Setup Printer Properties. Review Printing and Page Setup 

and Print Preview in the PrintKey-Pro Help Menu for additional information. 

See: Printing in the PrintKey-Pro Help Menu. 

 

Keyboard shortcut for Print Preview: Ctrl+W 

 

Print 

Ctrl+P 

Prints the Image shown on the screen using your selected Printer. When you are using PrintKey-

Pro settings, a pop-up with the PrintKey-Pro icon will appear on screen showing which printer is 

used; if you are printing from another program, your Windows Printer settings will apply. 

 

Notes: An alternate shortcut for Print the Desktop may be used when you right click on the 

PrintKey-Pro icon in the lower right of your screen and click on this selection. When this route to 

Print is selected, the PrintKey-Pro Toolbar will not appear in the print out. 

 

Checking (enabling) Direct Printing will cause the program to automatically print the screen 

every time the Print Screen key is pressed. 

 



Under Options you may also enable (check) Close after Print. This will automatically close your 

PrintKey-Pro screen capture immediately after sending the image to a printer. 

 

Printer Problems? 

 

(1) If you are unable to print, review your Selected Printer designation found in Page and also 

use the arrow at the right of the Page icon to review your Printer Setup and Properties settings. 

(2) Some printer factory settings are set to conserve ink. If your print out is too light, review the 

settings in that printer. Or you may need to replace an ink cartridge.  

 

Working Area 

 

 

 

 

 

 

 

 



The Working Space is the area below the PrintKey-Pro Toolbar. The Working Space is used to 

View, Paste, Load, and select a Rectangular or Circular Area of the screen. This space is also 

used to Insert Text or Free Hand Draw on the Image. 

 

To select a Rectangular Area, place the crosshairs on a corner area of the text and/or picture, 

hold down the mouse button and drag the crosshairs on the Working Space. Release the mouse 

button when your selection is complete. 

 

To Select a Defined Rectangle, a Circular Area, Insert Text or Free Hand Draw, right click 

while in the Working Space and then left click on the feature that you want to use. The shortcuts 

Ctrl+E or Ctrl+A may be used to open the Standard Editing window or the Advanced Editing 

window. 

 

 

File Menu 

 

  

 

When PrintKey-Pro is Open, the File menu at the top of your screen lists keyboard 

shortcuts for PrintKey-Pro. 

 

The keyboard shortcuts listed may be used when the PrintKey-Pro Toolbar is not shown 

on your screen. 

 

Close 

ESC key terminates your PrintKey-Pro screen capture. 

 

Note: When the shortcut menu (right click on the PrintKey-Pro icon in the lower tray) to Get 

Rectangular Area is used, pressing the ESC key will activate the PrintKey-Pro Toolbar. 

 

Suspend 

Suspends and disables all PrintKey-Pro activity. Uncheck Suspend to enable PrintKey-Pro 

actions. 



 

Refresh 

F-5 refreshes the Desktop. 

 

Load 

Ctrl+L loads the selected Picture File. 

 

Save 

Ctrl+S Saves the picture shown on the screen as a File. 

 

Print Picture 

Ctrl+P Prints the picture shown on the screen. 

 

Print Preview 

Ctrl+W Print Preview shows how the picture will be printed with your Print settings. Print Setup 

includes extensive page setup, size, orientation and text additions. 

 

Send Picture as E-Mail 

Ctrl+M Allows sending the picture as an E-Mail attachment. See Sending pictures as E-Mail in 

the Help Menu for e-mail setup. 

 

 

 

Get Picture of PrintKey-Pro 

Ctrl+G Captures a picture of PrintKey-Pro including toolbar and title. 

 

 

You may instead choose to right click on the PrintKey-Pro icon in the lower tray of your 

screen to use the following features: 

 

Automatic Save 

Starts or stops the Automatic Save feature.  

When Automatic Save is enabled, the screen will be captured in accordance with the Timer 

Setup (use arrow adjacent to the Clock icon to Setup). Check Automatic Save to Start. The 

Clock icon will read ON when Automatic Save is enabled.   

 

Uncheck Automatic Save to stop saving screens automatically. 

The Clock icon should read OFF unless you want to save at timed intervals. 

 

Reset to Default and Exit 

Click on Reset to Default and Exit to reset all settings to default and terminate PrintKey-Pro. 

Use to reset PrintKey-Pro in case of incorrect or undesired settings. 

 

Terminate PrintKey-Pro 

Click on this selection to Terminate PrintKey-Pro. 

 

Note: To place the PrintKey-Pro icon back on your screen after Resetting or Terminating 

the program: 

  

Click on Start, click on All Programs listing, scroll to find PrintKey-Pro and click to open the 

listing. 

Click on PrintKey-Pro below the main program listing in Vista or in XP follow the arrow to the right 

of the main listing and click on PrintKey-Pro at that location.  



 

 

Edit Menu 

 

  

 

When PrintKey-Pro is Open, the Edit menu at the top of your screen lists keyboard 

shortcuts for PrintKey-Pro. The HotKey shortcuts listed may be used when the program is 

Open. 

 

Undo 

Ctrl+Z Deletes or removes previous operations (max. 16) that have not been saved. 

If there are more than 16 operations, the first one will be overwritten. 

 

Undo Selection 

Ctrl+U De-selects a selected area. 

  

Copy 

Ctrl+C Copies the selected picture to the Clipboard. 

 

Paste 

Ctrl+V Pastes a picture from the Clipboard to an open Document page. 



 

Cut 

Ctrl+X Cuts (removes) the selected area when Auto-Crop in Options is disabled. 

 

Crop 

Ctrl+R Crops the selected area. 

 

Picture functions 

The arrow at the right of Picture Functions lists the following HotKey functions assigned in 

PrintKey-Pro: 

 

Ctrl+Alt+G  Grayscale colors 

Ctrl+Alt+I  Invert colors 

Ctrl+Alt+H  Horizontal Mirror 

Ctrl+Alt+V  Vertical Mirror 

Ctrl+Alt+S  Sharpen 

Ctrl+Alt+R  Rotate 90° 

Ctrl+Alt+B  Brightness 

Ctrl+Alt+C  Contrast 

 

Shift+Ctrl+F1  Resize to   640 x 480 

Shift+Ctrl+F2  Resize to   800 x 600 

Shift+Ctrl+F3  Resize to 1024 x 768 

Shift+Ctrl+F4  Resize to 1280 x 1024 

Shift+Ctrl+F5  Resize to   768 x 576 

Shift+Ctrl+F6  Resize to 1152 x 864 

Shift+Ctrl+F7  Resize to 1600 x 1200 

 

Standard editing window 

Ctrl+E Opens the standard picture editor. 

 

Advanced editing window 

Ctrl+A Opens the advanced picture editor.  

 

 

View Menu 

 

   

 

When PrintKey-Pro is Open, the View menu at the top of your screen lists keyboard 

shortcuts for PrintKey-Pro. The keyboard shortcuts may be used when the PrintKey-Pro 



Toolbar is not shown on your screen. 

 

Toolbar 

Selection of this feature enables the Toolbar. Uncheck Toolbar to disable this feature. If you have 

disabled the toolbar but want to enable the toolbar again, right click on the PrintKey-Pro icon on 

your screen and click on Reset to Default and Exit to allow the toolbar to appear automatically 

while using PrintKey-Pro. 

 

Note: To place the PrintKey-Pro icon back on your screen after Resetting or Terminating 

the program: 

  

Click on Start, click on All Programs listing, scroll to find PrintKey-Pro and click to open the 

listing. 

Click on PrintKey-Pro below the main program listing in Vista or in XP follow the arrow to the right 

of the main listing and click on PrintKey-Pro at that location. 

 

Centered 

Selection of this feature centers the image on the screen. Uncheck to disable this feature. 

 

Normal View 

F1 Shows the Image in its original screen size. 

 

Fit View 

F2 Adjusts the image size to fit the PrintKey-Pro Workspace. 

 

Restore Window to Default 

Resizes the PrintKey-Pro Window to the default Size and Position. 

 

Note: F5 will refresh the screen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Options Menu 

 

  

When PrintKey-Pro is Open, the Options found in the menu at the top of your screen may 

be enabled (checked) or disabled (unchecked) in accordance with user preference and 

various applications.   

 

Quality Filter 

Selects the Filter for rotating or resizing. Use the arrow at right to select the best Image filter for 

your application. Available filters: Mitchell, Bspline, Lanczos3 or Bell.  

 

Quality Rotate 

Preserves the quality of the image when rotating. 

 

Quality Zoom 

Preserves the quality of the image when zooming or shrinking. 

 

Sound 

Enables a "typewriter" sound when PrintKey-Pro is activated. A sound card must be installed in 

the system to enable or use this feature. Uncheck Sound if you want to disable this feature. 

 

Close after Print 

Closes PrintKey-Pro immediately after printing the image.  

 

Show Info Message 

Shows a small Information box about an image when printing or saving.  



 

Auto Crop 

Crops the selected portion of the screen when the mouse button is released. 

 

Automatic to Clipboard 

Copies the screen to the Clipboard every time PrintKey-Pro is activated. 

 

Disable this feature when installing in Terminal Servers. 

 

Automatic to Clipboard is virtual in most systems. 

 

Client Area Only 

Select this feature to capture the window without borders, the lower toolbars and blue caption bar. 

 

EXAMPLE: When Direct Printing and Client Area only are selected in PrintKey-Pro Options, 

pressing ALT+Print Screen will capture the screen without the lower toolbar and blue caption bar 

located at the top of the screen. To capture a selection without the upper toolbar, right click on the 

PrintKey-Pro icon in your lower tray and click on Get Rectangular Area.  

 

Include Cursor 

Includes the cursor in the captured image when this Option is checked (enabled). The cursor will 

be excluded from a screen capture when Include Cursor is unchecked. 

 

Direct Printing 

Automatically prints the screen every time the Print Screen key is pressed. 

Direct Printing may also be selected in the shortcut menu; right click on the PrintKey-Pro icon in 

the lower tray on your screen, left click on Direct Printing. Uncheck Direct Printing in Options 

or right click on the PrintKey-Pro icon in the lower tray on your screen to disable this 

feature. 

 

Footer Text 

Enables the entry of footer text. Click on the Page icon for additional Footer Text settings.  

To place text within the image of a screen capture see Insert Text in the Help Menu. 

 

Save and Picture Type Defaults 

Specifies the default folder and image extension when saving a screen capture. 

 

Shortcuts 

Follow the arrow at the right of this selection to enable or disable a shortcut to the Desktop, Start 

Menu, or Startup Folder. Use Startup Folder to activate PrintKey-Pro when Windows® starts.  

 

 

 

 

 

 

 

 



Monitor Menu 

 

 

  

 

This pull down menu is activated only if Multimonitor support is installed in Windows®. 

 

You may use this feature when a graphic card is installed to expand Windows to more than one 

monitor and the operating system is Windows XP®, Windows 2000®, Windows 2003® or Vista®. 

 

The maximum number of graphic cards PrintKey-Pro can support are four. You can have a 

mixture of PCI and AGP, but not ISA or EISA. When the monitor cards are installed correctly, the 

'Monitor' selection in the PrintKey-Pro Toolbar will appear black instead of grayed out. Click on 

'Monitor' to set up this feature in PrintKey-Pro. 

 

You may select which monitors PrintKey-Pro will use. All monitors selected in PrintKey-Pro 

'Monitors' will capture the complete Desktop when the Print Screen key or another Hotkey setup 

combination is pressed. Windows accepts a single Active Window assignment for printing, not 

multiple Active Windows, whereas Active Full Desktop selections for printing may be multiple. 

 

If a 'list index out of bounds' error message is produced when using the Multimonitor feature, then 

some setting within a graphics or video card is in conflict with or may be duplicating a PrintKey-

Pro setting. Example:  A Matrox® desktop card set to remember screen positions of applications 

by checking a box in the Matrox PowerDesk software configuration may cause a conflict with 

PrintKey-Pro. Disabling that feature in Matrox will resolve the problem for PrintKey-Pro.  

 

 

 

 

 

 

 

 



HotKey Menu 

 

 

  

 

Use this menu to select or change a HotKey to activate PrintKey-Pro functions listed here. 

Click on the Close box to keep the new setting. 

 

Selections: 

 

Get Desktop 

Get Desktop + Save 

Get Rectangular Area 

Get Active Window 

Get Active Window + Save 

 

The Default HotKey for Get Desktop is Print Screen.  

The Default HotKey for Get Active Window is ALT+Print Screen. 

 

Please enter the Modifier HotKey choice before entering the main HotKey choice. 

 

Not all keys or key combinations will work with WinXP, Win2000, Win2003 or Vista 

depending on your system and subject to key availability. 

 

Note: Keyboard shortcuts assigned within PrintKey-Pro are listed in the toolbar under File, 

Edit (see also Picture Function shortcuts), and View. 

  

 

Since Compaq®, HP® Laptops or Desktops use the Print Screen key for other internal 

purposes, another key must be used to capture the Active or Desktop window. The 'Pause' 

or 'Pause Break' key or a combination with the Pause key (for example, Ctrl+Pause) may 

be entered in the PrintKey-Pro Hotkey Menu to implement a shortcut compatible with 

PrintKey-Pro.  

 

 



Help Menu 

 

 

 

About 

Displays the version installed, the registration card and general information about PrintKey-Pro. If 

the program is registered in a computer, a name will appear in the 'Registered To' box. 

 

Register 

Used to register PrintKey-Pro and keep the program active in a computer. Downloads of minor 

upgrades will be automatically registered unless PrintKey-Pro is installed into a new computer, a 

new hard drive, or the program is lost due to a system crash.   

 

To complete the registration process, Copy and Paste or enter the registration name and 

Serial Number/Keycode information exactly as shown in your Registration confirmation e-

mail. 

 

Print and keep a copy of your registration receipt on file in case your computer crashes or 

you lose your copy of PrintKey-Pro when upgrading your computer or network.  

 

When the Register appears grayed out you do not need to re-enter your registration 

information. If the Register is black you will need to enter the registration information in 

your computer. 

 

To verify registration status, see About. 

 

PrintKey-Pro Help 

This Help Menu.  

 

 

 

 

 

 

 

 

 

 

 



Standard Editor 

 

 

 

 

CTRL+E may be used as a HotKey shortcut to the Standard Editor. 

  

Or: 

Click on the Edit icon in the Toolbar to activate the Standard Picture Editing Window. Click 

on Advanced Editor in this window to Preview your working image or add Special Image 

Editing. 

 

This editing menu will also appear on screen when you right click while in the Working 

Space and click on Standard Picture Editing in the pop up menu. 

 

Click on Close to keep the new setting. 

 

Grayscale Colors 

Changes the image to shades of gray. 

 

Invert Colors 

Inverts the image colors (Negative). 

 

Sharpen Colors 

Makes the image appear sharper. 

 

Horizontal Mirror 

Mirrors the image horizontally. 



 

Vertical Mirror 

Mirrors the image vertically. 

 

Emboss 

Embosses the image. 

 

Turn 90° 

Rotates the image 90° 

 

B & W 

Changes image to Black and White. 

 

16-65M Colors 

Changes color depth. 

 

Brightness 

Changes image brightness. 

 

Contrast 

Changes image contrast. 

 

Saturation 

Adjusts color saturation. 

 

Red, Green, Blue 

Adjusts color balance. 

 

Zoom 

Adjusts image size from 10% to 800%. 

 

Rotation 

Rotates the image by any angle from 0° to 360°. 

 

Sharpen More 

Sharpens the image slightly every time it is pressed. 

 

Blur More 

Blurs the image slightly with each pressing. 

 

Substitute Color 

To substitute a color in an image, click on and drag the left box to that color in the screen image. 

Then right click on the other color box at the right to place the palette on screen. Use the palette 

to select a substitute color; choose a Basic color, an existing Custom color or use the arrows to 

Define a different custom color. Click on OK in the palette to keep a new color. Check 

Substitute Color to implement your color substitution in the screen capture image. 

 

You may click on and use any of the color boxes in the palette to place your own Custom or 

Defined colors. Remember to click on Add Custom Color while in the palette to keep your 

Custom color in the palette. 

 

Click on the Save as Default box in the Standard Picture Editing Window if you want to keep 

your color exchange for another screen capture.  



 

Swap Color 

To swap a color in an image, click on and drag the left box to that color in the screen image. Then 

right click on the other color box at the right to place the palette on screen. Use the palette to 

select a substitute color; choose a Basic color, an existing Custom color or use the arrows to 

Define a different custom color. Click on OK in the palette to keep a new color. Check Swap 

Color to implement your color swap in the screen capture image. 

 

You may click on and use any of the color boxes in the palette to place your own Custom or 

Defined colors. Remember to click on Add Custom Color while in the palette to keep your 

Custom color in the palette. 

 

Click on the Save as Default box in the Standard Picture Editing Window if you want to keep 

your color change for another screen capture.    

 

Frame 

Add a frame around the image from 0 points to 20, and choose a frame color. You may add one 

or more sizes and colors to frame a screen capture. 

 

Change 

Change the image dimensions. If Proportional is checked, the image proportions will be 

maintained. 

 

Advanced Editor 

Use this feature to Preview and to use Special Image Editing like Bump mapping.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Advanced Editor 

 

  

 

CTRL+A may be used as a HotKey shortcut to the Advanced Editor. 

 

With this Advanced Picture Editor the image can be extensively manipulated. Select effects in 

the boxes at the bottom of this window. Use the arrows at the right of these effects to view all 

choices:  Contrast, HSV, HSL, RGB, User Filter, Equalization, Bump map, Lens, Wave, 

Morphing filters, Rotate, FFT, Gamma correction and Sharpen. Click OK to keep a setting.   

 

 

Timer Setup 

 

To adjust the Timer, select the pulldown menu (down arrow)  next to the Clock icon. 

 

 

 

Use this menu to setup the Timed Automatic Save. This feature may be used to obtain 

unattended snapshots of performance data, or to capture satellite images from the Internet. 



  

 

All snapshots are saved under the Default Folder and Name + Extension. This folder can be 

setup in the Options menu in Save and Picture Type Defaults. 

 

Set a Start time + Date and End Time + Date. To allow continuous captures until stopped, do 

not specify an End Time. You may also choose not to specify a Start Time, to enable immediate 

timed capture. 

 

Select a snapshot Interval from 10 seconds to 24:00 hours. To adjust, click on the time 

(Seconds, Minutes or Hours), and press the up or down arrow or place the Hand on the part you 

want to change and enter your change. When you are finished with the setup, press Start. 

 

As soon as PrintKey-Pro is closed, the timer will be activated. 

 

To disable the timer: 

 

(1) Press the Print Screen key to open PrintKey-Pro, then press the Clock button until it is turned 

Off. 

 

Or 

 

(2) Right click on the PrintKey-Pro 'Hand' Icon in your lower tray and uncheck Automatic Save. 

 

Define Captured Rectangle 

 

Use the arrow at the right of the Clock Icon to Define a Rectangle Size and a part of your screen 

that you want to capture automatically when the Clock is On.  

 

To setup automatic saving of a selected part of your screen: 

 

(1) Click on the arrow adjacent to the Clock icon. 

(2) Click on Define Capture Rectangle.  

(3) Use the crosshairs to outline the Rectangle Size. 

(4) Using the grips in the body of the rectangle, hold your left mouse button and drag the 

rectangle to the position of the screen that you want to capture.  

(3) Press ESC. 

 

All timed screen captures will then save only your selected portion of the screen. 

 



Save and Picture Type Defaults 

 

  

 

Click on Options, click on Save and Picture Type Defaults to use this menu.  

 

To change a background color: 

 

(1) Click on a selected Color box. 

(2) The Color palette will appear on screen. 

(3) Select and click on a new color.  

(4) Click OK in the palette. 

(5) Click on the Close box in the lower right of the menu to Save your settings.  

 

Auto Numbering if checked will add a number to the saved file. 

For example: Picture0001.png, Picture0002.png…etc. 

 

Select the image type to save the file. GIF and PNG file types are recommended because these 

use less memory and are compressed. 

 

To select an image type and choose a folder for your screen captures: 

 

(1) Click on Options in the toolbar. 

(2) Click on Save and Picture Type Defaults. 

(3) Select an Image Type in the menu. 

(4) Enter a Picture or File Name. 

(5) Check or uncheck (disable) Auto Numbering as preferred. 

(6) Click on the Change box in the Save and Picture Type Defaults menu to designate a Folder 

for your saved screen captures. 

(7) Click on the Close box in the lower right of the menu to Save your settings. 

The Automated Save places all snapshots under the folder  'Folder to Save the Pictures'.  



 

 

Sending pictures as E-Mail 

 

  

 

CTRL+M may be used as a HotKey shortcut to Sending Pictures as E-Mail. 

 

Click on the Close box to keep new settings. 

 

The simplest way to send a Picture as E-Mail is to use MAPI Send. This will work only if 

you have a MAPI-enabled Mail Program such as Outlook®, Outlook Express®, Netscape 

Communicator®. 

 

Setup to send E-Mail with PrintKey-Pro as follows: 

 

Open PrintKey-Pro and click on the Mail icon in the Toolbar at the top of your screen.  

 

Mail Server (SMTP) is the "post office" that you are currently using. To find this 

information look in your E-Mail program under Tools, click on Internet Account, Mail, and 

Properties. Under Servers you will see your current (SMTP) server listing in Outgoing mail. 

Copy (Ctrl+C) and Paste (Ctrl+V) the server information into the PrintKey-Pro Mail Server 

(SMTP) area. 

 

For User ID: Enter your usual Internet provider Logon information. 

 

In From: Enter your name. 

 



In Subject: Type in your message title. 

 

In Body: Type in your message comments. 

 

In To: Enter the destination address. 

 

In Attach Picture As: Select the format you wish to use. PNG or JPG are recommended 

because these will compress the image. (BMP is used for large files.) 

 

Select the type of code you wish to use. HTML is commonly used. 

If your E-Mail program is set to send using Plain Text, you cannot send graphics placed in 

the body of an E-Mail. Change your E-Mail program setting to HTML.  

 

To place a graphic in the body of an e-mail you must have Send Pictures with E-mail 

enabled in your e-mail program to allow an Insert.     

 

Select SMTP or MAPI to send. (Review Windows® Help Menu for additional information if 

required.)  

 

Page Setup and Print Preview 

 

  

 

Click on the PAGE icon to enable the following selections. Clicking on the arrow adjacent to the 



PAGE icon will direct you to your printer driver and setup in Windows. 

 

The settings in the boxes at the left of the Print Setup and Page Preview menu (Selected 

Printer and Paper Orientation, Picture on Paper, and Footer) are PrintKey-Pro settings. 

These settings will remain unchanged within PrintKey-Pro until alternate selections are made or 

you Default. These Page selections will apply when PrintKey-Pro is controlling your 

printing.  If instead you select Default or move your screen capture to a Windows 

document to print, then your Windows printer settings will apply. 

 

Select the Printer you wish to use when using PrintKey-Pro. Select Orientation (Portrait or 

Landscape) and Number of Copies before printing the picture. 

 

Position the Picture on paper by choosing Centered, Top Left, Top Right, Top Center, Bottom 

Left, Bottom Right, Bottom Center, Center Left or Center Right Aligned. 

 

The Picture can also be resized (enlarged or reduced) when you adjust Picture Size in % or 

Size as % of Page. To change size you may use the adjacent arrow settings or you can place 

your cursor within the number boxes and direct the changes using your keyboard numbers. 

 

Optimized Printing will reduce a large print job to more than half size. This feature is ideal for 

Network printers. 

 

Grayscale will change all print to grayscale. This setting is ideal for black and white only laser 

printers and will save color ink in color printers when this feature is checked (enabled). 

 

Choose Footer information to be added to the bottom of the page: 

 

Date and Time 

User Information 

System Information 

Footer Text 

 

Select 08Cpi, 10Cpi or 12Cpi to choose the print size of your inserted footer information. 

 

Under Footer, select the Footer Text feature then go to the Footer Text box below to compose 

and enter an added text. An alternate date or any information can be entered in the Footer Text 

box. Spaces can also be entered before the footer text information to center or place your added 

information at various locations at the bottom of the printed page. Click on the page located within 

the Print Preview box to zoom in on the placement of your text. 

 

After reviewing or changing your Printer and Paper Orientation, Picture on Paper and Footer 

settings, click directly on Print in this menu to direct your printer driver to use the PrintKey-Pro 

settings. When you are using the PrintKey-Pro program printer settings, a pop up picture of 

the PrintKey-Pro icon will appear which will identify the assigned printer, unless you have 

disabled Show Info Message in Options. 

 

The Default and Setup boxes found in Print Setup and Page Preview are Windows settings in 

your printer driver, not PrintKey-Pro settings. Clicking on Default will select your assigned 

Windows settings instead of the PrintKey-Pro settings. Clicking on Setup will go to your 

Windows Printer settings and driver. You may also check your printer settings as follows: Click 

on Start, click on Control Panel, click on Printers, double click on the printer you wish to 

use with PrintKey-Pro to review your Properties settings. 

 



Click on Close to close the Print Setup and Page Preview menu. 

 

Click on Default and then click on Print in this menu to select your Windows and printer driver 

settings instead of the PrintKey-Pro settings.  

 

Click on your screen capture page in the Print Preview box to zoom in.  Use the arrows or with 

your cursor on the scroll barsaround the Print Preview box and hold the left mouse button to 

move your view of the picture. Click on your illustrated page again to zoom out.     

 



Select circular area 

 

While in the Working Area of PrintKey-Pro, right click. A menu will appear with Select Circular 

Area as an option. 

   

 

 

(1) Click on Select Circular Area.  

(2) Place your cursor at the center of the area you want to capture. 

(3) Hold down your left mouse button and move your mouse to drag the crosshairs to select an 

oval or circular section.  

  



 

 

To capture a perfect circle, press and hold the ALT key while dragging your mouse. 

 

As with Rectangular selections, the circular selection can be moved in the Working Area with the 

grips within the circular area while holding the left mouse button unless you have Auto Crop 

enabled. To disable Auto Crop, in the PrintKey-Pro toolbar click on Options, uncheck Auto Crop.  

 

Insert Text 

 

 

 

 

 

 

While in the Working Area of PrintKey-Pro, right click then select Insert Text. 



Select the font, size and color, click OK in that menu, then enter your composed text in the 

menu. 

Or click on the from Clipboard box, or use CTRL+V, to Paste Text from the clipboard. 

Position the cursor in your screen to place the text, then press the left mouse button. 

Your Insert Text settings will apply until you change your font, size and color or enter a different 

text. 

 

   

 

Free hand draw 

 

  

While in the working area of PrintKey-Pro, right click and select Free hand draw. 

 

 

 

Keep last used selections (Yes or Close menu) or click on 'No' to make new selections.  

Choose Pen color in pallette and click OK and choose Size width (1-10 Dots) and click OK. 

Draw on the image. To finish drawing, release the mouse button. 

 



 

 

 

Your settings in Free hand draw will apply until you change your color and size.  

 

 

Status Bar panels 

 

  

 

The Status Bar, located below the PrintKey-Pro Working Area, shows information about the 

picture (Width, Height, Colors). 

The color directly under the 'cross' cursor is displayed in the Status Bar as Decimal and 

Hexadecimal Notation. 

 

The Status Bar information is useful to identify the Size to Define a Rectangle or to identify 

a Color in an image.   

 

 

 

 

 

 



Digital Signature 

 

 

 

 

 

 

This guarantees the program authenticity. Any modification of the program 

or installer package will invalidate the certificate causing the  Windows 

operating system to issue a warning at the time of installation. 

 

 

 

 


